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2-3. VAT ALAEY OFSHT
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(5). EBIUSB B—h~v ¥

INHED~y ZiTENE N, USB 2.0 LA L CikEF &N/ USB ¥ —7 L &i@ L T, 2 DDA

JNUSB 2.0 A— M a4t L E 7,

246810

FP-USB1

FP-USB2

=% EHVERS =% Y AT
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3 Data0 - 4 Datal -
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7 T—=A 8 T—=A
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{usB-PWR1

=8

1@ 1 [m]
2@ 2@
Ps2-PWR1 3 [(®] ) =)

Disabled  Enabled
(Default)

1@ 1 (m]
2 2
USB-PWR1 3 H 3 B

B-PWR2
us Disabled Enabled
(Default)

PS2-PWR1 :
vrl2va—h (F744H)
b &R L E T,

¥R = R/ Y URR— I TOY =2—7 7 v THEROY AR —

Er23va—h: F—AR—F/~VRAR—FTOV=—7 T v ROV R— FNEHFHZLE

T
USBPWRI :

B 123 a—bh :USBlR—hTOU=—27 7 v THEZ BN LET,
cUSBl AR— R TO U =—2 7 v FHEREZ AR L £,

vr23va—h (F74NH)

USBPWR2 :

L1233 —h USB2R— FTOY=—27 7 v FHte 2 N LET,
cUSB2 IR— R TO Y =—2 7T v FHERER AR L £,

vr23va—h (F7xH)
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TN EDTRTOT ¥ %A L.

W ANV T =T 4 A ax 7 X &2FEHT 0T, IERr—T7 NV E2kE, B2 56, BLOE Y
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9. MEXSF7 47 AF—bRrY b

ZDAT Yy ME, AGP 8X FTH SV a v DAGP /T 7 4 v 7 AH— K&V R—FLET, 7
TT7 47 AH— ROFEMZONTIE, %40 Web 4 hE2SL T ZEN,
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1

IDE1

E

;
§§
FDCl a7 X334 VA Y 2axr 270y = —7 L TRRK2OO7ryE— 74T %
B A N TEET, VR —TNADOEVWFICHD 1| DO ARy Z %R R— RO FDCL (T4

L, bORFO2o0axs %70y =T 4 A7 RTA4TIZEREL T ESW, @E, &
AT AIRER Ty =T 4 A7 RT4 7131 27 TY,

E: VAR —TNLDORVEIEIFDCI AR— & 7 a vy E—aRx 7 ZOWFDO L 1 IZEbYE 5%
ERH Y ET,

IDE2

FDC1

oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo

ZIDER—bhaxs ZTiF 408 80 % 7 4,

Master Drive

3 a3k Z® Ultra ATA/66 VR r—7 L&~ T Black Connector
Ultra ATA/100 E— R TR K2 2D IDE KT A 7 %% 40-pin IDE piug
flf}%@— HZ & NT % i TO on the motherboard

Blue Connector
VR =T VORENEON (FWaxr4) 220
R— RO IDE A — MIHER L, WOz 2
ODaARTH (KELBOaxs ¥y Z—FKRJ4
TOaxy ZITHEE LT T80, Slave Drive
Gray Connector

H: VAR —T N T2o0D K747 Z8Hid HR0IC, "Master" & "Slave" BIfRZHEL T 72
EV, VR =T A DOFRVERL IDE R—hEN— R KIA4 T axs ZOlFOE . 1 I2h&b
TLEMERDH Y F9,
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an. YUY 7V ATA X7 &

IRHDaRT ZiE, Serial ATA 77— 7 /R TEF v RAHIT 1 DD Serial ATA 734 2%
Beli T B 72 DI HE STV ET,

o
S

?
3]
<
g
<
k]
@
12

="

(12). AT —BRA VT —%

LED2 (5VSB): Z @ LED i, FEHFIEENERIERENTND & SITRUITLET,

J 5vsB)
LED2
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(13). /SR DOEEE

LPT1 LAN
Mouse
A @Goeoooooooooo>© Mic In o
o 0% ©C000 0000 OO0O0O @ Ij [I
O O

_|_O Line In = = = =

®) — —

oo O |=l| =

‘ — ) ELER. = = = -
Keyboard COM1 AUDIO1 USB1 UsB2

CURPS2 U RICHRHLET,
F—AR—F:PS2 F—AR— FITHm LET,
LPT1: ZOEET 0 FaLz Y R—rTE57V U EZRFZOMDT A ZTHRE L ET,

COM1: ZO@EfF7m havzdR— b T 20T T A, ~ U RAETIEEDOMDOT /S A ATHHGE
LT,

AUDIO1 :

MiclIn : S5~ A 7 b7 7 7128k LET,

LineIn : N4 —F 4 Y —ZANb T4 07w MR LE T,

F.L/FR. BiEE / BiEAR) :51 F v RAVERITEFED 2 F v RV F—F 4 4 25 LAOHIE
7E L RIHA T ¥ R HSR LET,

LAN : #PNiEEHM (LAN) 2Bkt L £,

USBI/USB2 : A¥ ), TUHXNVAE—H—, T=H, ~YUR F—FKR—RK N7 FTIUXIL
HAT, PaAAT 4 v I7REDUSB T A ATHHE LET,
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# 32 BIOS IZDOWT

ZO=YW—R—RNEF /T LA[FEZ EEPROM ZEfit L, BIOS =2 —TF7 4 U T 4 2 HHT5HZ
ERTEET, BIOS EAAL L AT )37 0t w4 L ENEBOR TRIEDRARL L%
WS 2707 T A5 TT, ~P—R—FEROMIT7Z0, VAT LEFEHER LY, “Ey b7
v T OFEITHFRTHEXIZET, BIOS By N 7T a s I e LET, KAETIE,
BIOS 2 —7 4 VT 4Dy N7 v 7a—T 4 UT s &3 LET,

VAT LADERE A NTT B E, BIOS A v —UNBMEICFRSN, AT YRS T NEBEEG
L. KORA vy e—URNHHEICERINET,

PRESS DEL TO ENTER SETUP

AT AHNCA v —U BT 5. <Ctrl> + <Alt> + <Del>F —Z#37y, v EBa—F Ly —
POV hREZVEMLTAT LAZHEZEILET, ZNDH0 2 DOFENKRBLESEA DA,
EBFEAFT I LB ELA T LTV AT AZHENTAZ LN TEET,

<Del>F—ZM L7, AV Ama—BEPIRRINET,

Phoenix — AwardBIOS CMOS Setup Utility

» SoftMenu Setup » PC Health Status

» Standard CMOS Features Load Fail-Safe Defaults
» Advanced BIOS Features Load Optimized Defaults
» Advanced Chipset Features Set Password

» Integrated Peripherals Save & Exit Setup

» Power Management Setup Exit Without Saving

» PnP/PCI Configurations

Esc : Quit T ] » < : Select Item
F10 : Save & Exit Setup (M1609-W03627-6A7K4A19C-00)

Change CPU’s Clock & Voltage

VAT LORENEMRER M 572018, B HATHAS BIOS A =2 — %tz TR L T
WE9, BIOS v b7 v Pl & AETRE LERIIZBRO-O0 DT, iR RSN
HOEREBIZ—H LRI EHHY FT,

BIOS v b7 v T AL v A =a—ITid, BEOA TV a v RERENET, KEOLITFDOS—
TTCINDLDAT v arEAT v I NA AT v T THALETR, 2 TR SRS —I2o
W, ETHICHAW- LET,
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Esc:
ZDOREEPTE, BIOSt Y b7y T EEKT LET,

T |-t
AA VA= 2—TINOLDORZ 2T & RELITMELET LA TV a VERIRTE ET,
Fi0:

BIOS T A =4 D&y NT v TNET Lizh, ZORYUEHLTI HNDNRT A—F ERTF
L. BIOSty N7 v T A=a—%2KTLET,
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3-1. SoftMenu Setup

SoftMenu = —7 4 U 7 41X, CPU OBERE T 10 7T A9 572D ABIT OISR TIEMD
Ya—322CY, CPUFSB#E, v~ VF7I7A4Vv 77274, AGP&PClZu v/ CPU=7T
BECHTARTONGA—HIT 2 v FCEET D2 LN TEET,

Phoenix - AwardBIOS CMOS Setup Utility
SoftMenu Setup
Brand Name : AMD Sempron(tm) Processor 3100+ Item Help
Frequency : 1810MHz
CPU Operating Speed Default
X - Multiplier Factor StarUp
X - CPU FSB Clock (MHz) 204
X - AGP Clock AUTO
Voltages Control Default
X - CPU Core Voltage +0mv
X - DDR Voltage 2.60 Vv
- DDR Ref Voltage -2.5%
- AGP Voltage 1.50 v
X - Chipset Voltage Default
Spread Spectrum Spread 2%
T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Brand Name:

ZDOT AT AIF CPU DET VA,

Frequency:
ZOT AT AEICPU ONE 7 vy 7 lEEFRLET,

CPU Operating Speed:

ZDOT AT A, BEWD CPU DH A 7 LIRS T CPU DAL —F T HEEZFRL
F 9, [User Define] (L—V —EFK) A7 a v a@RTDHL v=aT Lt a it AbIE
MWTEET,

User Define:

B ym oy JEREANE 0y ) DREERD L CPUE X A—VEBEZ D2 LRHY £,
PClOF v 7ty hERIET P OAERL Y bEWVEAERICHET AL ATV EV2—/b
TT— VATLITvva, N—RT A AT RTATDTFT—Fr A, VGA 51— RhoT K
I T — ROBEIELTHL BA R H Y £4, CPU DA DR EIZIAED HHITIZH Y 8 A,
EILIEREFT V=T VI T A MDD T EEOT 7Y r—a  TIEEHR LRV TL
7ZE0,

Z—PF—r=2 T
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Ak Z 2 5 BOEICH L TRAEIT TE £ A, ZIUCER T 2 v F—AR— N E I3 ER L E OH
B L CHthidE Rz AbRVn b D& LET,

#  Multiplier Factor:
DT AT AiE WY 72 CPU DR AR T LET,

#  CPU FSB Clock(MHz):

ZDOTAT A, CPUTRY M A RARZROEEZFHELET, B0 172 CPU OHARHIRRIZ
L oT, ZOEEDOANRAFEELBZ CRELEZHEIIFR— FSRETAN, HEHIShEEA,
#  AGP Clock(MHz):

ZDOT AT AE, 66MHz 725 100MHz £ T AGP 7 1 v 7 HEZHEL£3, AGP LEOHIR
LY, ZoEHED s 0y VEEEBA TRE LEZEEIZR— FENETH, HEHIVWE-LE
A,

Voltage Control:

ZOF T a N T AN NOELEE 22—V —ER LI EEEZY Y B E T, BIEOETRE
PR TE RNV IELL RAWEADORE  ZORTEIET 74V FOEFIZLTBNWTLES
W, A7 3 “User Define” (- — ' —E2) (X, KOBEZ FETRIRTX 7,

# CPU Core Voltage:
DT AT AiE, CPUDaTEELEIRLET,

¥ DDR Voltage:

ZOT AT A%, DRAM OEEEZFRLET,

# DDR Ref Voltage:

ZOT AT NI FOWENEHT 720 DRAM A1y hCRE L e 5B REIELBIR L ET,
#  AGP Voltage:

ZOT AT AL, AGP OBEEER L ET,

#*  Chipset Voltage:

DT AT AL, Chipset DETZTIN L E T,

AR BB TCEERELTT) & VAT LARALEILR-720, CPU BMEETLHIZ LS 2d
DET, TOMBEFDERLTORVIRD, 774V FOREDEFICL TRBNTI SN,

Spread Spectrum:

EMC (Electro-Magnetic Compatibility Test) 7 A MZiX, RS HRONDL LHICTh b4
Ty a v EFE LTI N, FRRBEEARVEY . COBEIET 74V hOFEEICL TN
TLE3W,
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3-2. Standard CMOS Features

Phoenix - AwardBIOS CMOS Setup Utility

Standard CMOS Features

Date (mm:dd:
Time (hh:mm:

IDE Channel
IDE Channel
IDE Channel
IDE Channel

\AAA

Drive A

Floppy 3 Mode

Halt On

Base Memory

Extended Memory

Total Memory

yy) Sat. Jan 1 2005
ss) 0 : 6 : 56

0 Master None

0 Slave None

1 Master None

1 Slave None

1.44M, 3.5 in.

Support Disabled

[All, But keyboard]

640K
523264K
524288K

Item Help

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F6: Fail-Safe Defaults F7: Optimized Defaults

F5: Previous Values

Date (mm:dd:yy):

ZOTAT A (AL [FIORATHET 2 Af (@F, B/EOR) Z2RELET,

Time (hh:mm:ss):

ZOT AT HE[EE]L D).

O THET 2 B B, BUEORRH) Z8ELET.

Z—PF—r=2 T
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% IDE Channel 0 Master/Slave, IDE Channel 1 Master/Slave:

<Enter>F¥—%27 Vv /95L&, $TA=a—1ZAVET,
Phoenix — AwardBIOS CMOS Setup Utility
IDE Primary Master

IDE HDD Auto-Detection Press Enter Item Help
IDE Channel 0 Master Auto

Access Mode Auto

Capacity 0 MB

Cylinder 0

Head 0

Precomp 0

Landing Zone 0

Sector 0

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

IDE HDD Auto-Detection:

ZDOT AT LTIE <Enter> ¥—%TZLIZLS>TIDE R4 NONRTA—Z & TE D &
HTlp o> TWETY, /T A—Z 3l BICHBIMICF R SNES,

IDE Channel 0 Master/Slave, IDE Channel 1 Master/Slave:

[Auto] (HEh) IZRRET 2 &, BIOS X EDOFMED IDE RT7 A 7 2MH L TS 0E2 BEINICT =
v 7 LET, BAOTRIATEZERLLEWGA, ZhE [Manual] (v == 7 /L) IZEEL, /X7
A—HDERETEICEM L COND I EEMB LT EIN, ELWEREZEDITIE, T/31 A
A—H =PRI 2 HERABIELZ SR L TIIES 0,

Access Mode:

DT AT HIBHEND IDE T34 AT 7 AT HE—RERINRLET, ZOTA T L%ET
T4 D [Auto] (HE) BREDEFICLTHL & HDD OT 7 ¥ AF— F& HEAYITHIE L E
T

Capacity:

IDTATEIT A AT RTATOBBLEZOREEZFRLET, I, T XWEXT 4 A7 F
Ty 7Tl T RNORIND T A=~y NERT A AT DY A XLV N BEHAREL 25T
E9,
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Cylinder:
ZOTAT NIV A DOEERRLET,

Head:
ZOT AT LIEFOA/FIAS v FOFERHR LET,

Precomp:
IDTATHE, FRAEA IV T EERET DLV X ORERRLET,

Landing Zone:

DT AT AT, FHY/EABANYy KOS o F 40 7 — L LTHESND Y Y VA DFE
BEFRLET,

Sector:

IDTATAE, FT7v 7B 0Ot s ZOEAEMERLET,

% Standard CMOS Features Setup Menu (R YD 9 :

Drive A:

IOTATAIWMONTeT7ry e = FI7A47 @%, NI4T ADH) OFATaRELE
R

Floppy 3 Mode Support:

IDOTAT LT, BRDa V2 —F L AT LD 3F—FRT7uy b —RI7 47| ZfEH
L. RIALT7 A, B, ST ABESTDORIA THERTHZENTEET, AAEEDO VO Y
E— NI A4 TEHEHLRWES. 57 4/L h® [Disabled] ((EFARTAIHE) HEDEFICLTL
RN

Halt On:

ZOTAT HE, VAT LAORBTICE T BRSNS A VAT LA2BIET 0 E S e
WELET,

[All Errors]: A7 A7 — M, BIOS @M TRNT T — 2+ 5 L LT FELET,
[No Errors]: A7 A7 — NI, =7 —% K+ 2EELET,

[All, But Keyboard]: ¥ A7 L7 — NI, F—FR— K27 —LSHOTXTOZT — 2% L TEIE
LET,

[All, But Diskette]: ¥ A7 A7 — b, T4 A7 v b T —LAHOTRTOTT—T% L TEIE
LT,

[All, But Disk/Key]: ¥ A7 A7 — M, T4 A7 v hETFF—HR— F= 7 —LISOTXTD
7= L THEIELET,

Z—PF—r=2 T
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Base Memory:

TDTATHE VAT IIA VA =LV ENTEERAEY) DBEEZFRLET, EAAEY OHE
1% 640K ZHEH L7232 AT A OEA—KANTIL 640K TR, v —FR—FIZEHIZEL DAE
YUY A XA A M—NTHRILETEET,

Extended Memory:

ZOTAT AT, VAT LAORBPICHRE SNIERAETY OREFRLET,

Total Memory:

ZOTATAE, VAT LATHHATE DR AT 2FRRLET,

KU8
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3-3. Advanced BIOS Features

Phoenix - AwardBIOS CMOS Setup Utility
Advanced BIOS Features

Quick Power on Self Test Enabled Item Help
» Hard Disk Boot Priority Press Enter

First Boot Device Floppy

Second Boot Device Hard Disk

Third Boot Device CDROM

Boot Other Device Enabled

Boot Up Floppy Seek Disabled

Boot Up NumLock Status On

Security Option Setup

MPS Version Ctrl For OS 1.4

Report No FDD for OS No

Delay IDE Initial (Seconds) 0

Full Screen LOGO Show Enabled

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Quick Power On Self Test:

[Enabled] (fEHATHE) IZEXEL TVWD E, ZOTA T ATV AT AOERE A N LB ERS
YENTT A NPOST)DEE % EiFE3, BIOS 14 POST DWW 203D F = v 7 ZHEAE LI Y
Ax v T LET,

Hard Disk Boot Priority:

ZOTAT hiE, N— F?“47\7@7‘~ NMESENERL AR L £ 97, <Enter>F— & 442 L2k
ST, ZDOY T A=a—ZAY, ZZTHREENTNA—RT 4 A7 2V AT LEEIO DD T —
M= U ARICRIRT DR TEET,

ZOTATHIE VRRIRBIRT — b TFARA AT AT LD ENPII[NN—RT 4 A7 |DF T 3
VIRBDHEEOHRBRELET,

First Boot Device / Second Boot Device / Third Boot Device / Boot Other Device:

[First Boot Device] (5 1 77— k7 /3A R), [Second Boot Device] (5 2 7 — k7 /34 R), [Third Boot
Device](33 7 — F T /A R) TA T ATEAENERETHE 1, B2, B3 T4 T7E2BRLE
¥, BIOS ITBIR LI RTA T DL~ v Ao TANRL—T 4 VIV AT LERBILET,
UED32DT AT LUNDT SA AERE) LI WA, (DT /3 A R % jfsh] % [Enabled]
(FERATEE) ICRE L T ES0,

Boot Up Floppy Seek:

WD 2 ODA T 3, Disabled( 7 5)FE 721% EnabledfE T 2) B3 ETE LT, T 741
M Enabled(fE/H L 7220 )T o 7 7 4 /v NDFREIL Enabled. TY, ZOEHEX, BIOS 28, Lt

Z—PF—r==2 T
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@ First,Second, Third D 3 DD 7' — MERRLISL DT SA ANET— D L ARELET, [
B ICRELETE, LR TERELEISOEBNOLDOHRT—FLET,

Boot Up NumLock Status:

ZOTATHE, VAT LABPEBET D LS ICHEF—A—FOT 7 A FOREEZRELET,
[On] : HFx—& LTOKMEF— v FHEHE,

[Off] : KE1F—& L COHMEF— 3y PR,

Security Option:
ZDOTATAE, VAT ANNAY— RETRTH X - VAT ABEEIT L7200, E£21F
BIOS Y N7 v FITAD L EDHNEPRELET,

[Setup]: /SAU—REBIOS By b7 v T 7/ BATHEEOHRTRENET,
[System]: /XA U — RiZa o —Z N LE#d 572N EREhET,

X2 VT A BEEE BT HITIE, A A 2 A ==2—T Set Password Z3EIR L F 4, XRT—F
EANTDHEDICERENTHMHEANIETIZ, <Enter>F—%2 LTS, X2V T 4
EERERT D E VAT AN T — L, HHIZBIOS Oy b v 7 A=a—|ZHHIZT 7 B ATE
HEHTD EI,

E:RNRY— FEENRNWTLEEWN, mRTU— REENTEEA, v Ea—20r—A 2R
T, CMOS DT _XTOEREZ VTIZL TRV AT AEBE LT 28, ZORA. LI
WRELTEITRTOL T a iy & ET,

MPS Version Ctrl For OS:

ZOHEHAIX, 2O —R—FRHEATD MPS (ZETat v ) o=V a UEREL
F9, TOTAT LI, TDT 74V OB EDEFIZLTBNTTFEN,

Report No FDD For OS:

[Enabled] (BEFHFIHE) ICRET D L. ZOTAT ALV Ty E—FT 4 AT RTA4THLT
L OE VWAL —T 4 VTV AT AEEITTEET,

Delay IDE Initial(Seconds):

ZDT AT XY, BIOS [TEBIERH % 5] X 4EI1XF Z L2 X » T—EOH W F 72455472 IDE 7
NAREYR—= R THZENTEET, HERELTIE TAAL AEYIL L=V EETE S
Yl %3 5 72 OBERFF AR < 72 0 37,

Full Screen LOGO Show:

ZOHBITBEWHT L EaEHO R TE2RT I EEEED,
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3-4. Advanced Chipset Features

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Advanced Chipset Features

» DRAM Configuration Press Enter Item Help
» M1689 Configuration Press Enter
» AGP Configuration Press Enter
» HyperTransport Config Press Enter
ALI HPET Disabled
Init Display First PCI Slot

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

% DRAM Configuration:
<Enter>F—% 27 V7 92L YT A=a2—ITAVET,

Phoenix — Award WorkstationBIOS CMOS Setup Utility
DRAM Configuration

DRAM Timing Selectable Auto Item Help
X - DRAM Clock Auto
X - CAS latency Time Auto
X - Row Cycle Time Auto
X - Row Refresh Cycle Time Auto
X - RAS# to CAS# delay Auto
X - RAS# to RAS# delay Auto
X - Min RAS# Active time Auto
X - RAS# Precharge Time Auto
X - Write Recovery Time Auto
X - Write to Read Delay Auto
X - Read to Write Delay Auto
X - DRAM Command rate Auto
X - Burst Length 4 beats
X - Bank Interleaving Enabled

32 bit Dram Memory Hole Auto

MTRR mapping mode Continuous

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

DRAM Timing Selectable:

CD7 AT AIDRAMZ 1 3 > 7 E— F&EIZERL £9.“By SPD” ICF%E T 5 & .BIOS iZ DRAM
EY 21—V SPD T — 2 &iHmANY . HEMICRFENEICEHELET. CO7 17 A3EEE
D “Auto” FREICLTIBNTL 23,

# DRAM Clock:

Z—PF—r=2 T
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ZDT AT L%, DRAM EY =2 —/L® DRAM 7 v v 7 23%E LE T, DRAM £ ¥ 2 — /L3RR E
Lirmy 7Y R—bLARNE, VAT MIREEIL D, BEITE 220 ET,

[SPD IZ & 5 ]ICE%ET 5 &, BIOS i DRAM E ¥ 2 —/L0) SPD 7 — & & {iHiA T, HfHS
TWAEIZL > TDRAM 7 1y 7 2 HEWICRRELET,

#  CAS Latency Time:

3ODATvar, 225 DIEMATLIILENTEET, 774/ FORIEL 2.5 T,
SDRAM fEEEICHEVY, SDRAM CAS (T LT RL AR ha—7) LA T —F A LEERY
HIENTEET,

#  Row Cycle Time:

ZOTAT AL, RAS#H 777 4 TR RASHT 77 ¢ 7THEM, EZXF A7 OREBY 7Ly
oM EfRE L E T,

# Row Refresh Cycle Time:

IOTATHE, BBV 7Ly aT 07 4 T RASHT 77 1 THETE 721X RASHEB) Y 7 L
vV a R ERE L ETS,

#* RAS# to CAS# Delay:

ZOT AT AL, B CRERICKRT 2 RASHT 7 7 1 7%t CAS"#i A H & B ZIE L 7,
# RAS# to RAS# Delay:

ZDTATHE, BB T DORASHE T 7T 4 75 RASHT 7 7 « TRIERE ZEE L 7,
¥  Min. RAS# Active Time:

ZDOT AT AL, BAND RASHT 7 T 4 TR AR E L £,

#  RAS# Precharge Time:

ZOT AT AL, RASHT Y F v — VR ZEE L E T,

#  Write Recovery Time:

ZOTAT AL, RBICESAALLET =2 N DRAM IC & 0 ZEICERESHTHOME SN
MazfELET,

#  Write to Read Delay:

ZOT AT DI ROFH AR RONH ERDICH L TREDIEY AT T —F A ha—7
WBE< AL D ER D B RIE SR AR E L ET,

#*  Read to Write Delay:

ZDT AT AIFHAFIABD L EEIALOBILZIHE L ET,

# DRAM Command Rate:

2 ODF T ar 2T a<wy REFIZIT a~<y REMHT5 2N TEET, T 74/ b
ENL 2T 22 FCT, AA N (V=27 Vo) BDHLTIAEYT RLAZEET D L X,
avy RORBIREZ R L 7,

#  Burst Length

DDR SDRAM E ¥ 2 —/WFN—Z b E— FERELET, N—A FE—FLIF 4 ET8 v s
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—YarOrn s AWEE READ (SiAiA#A) F721X WRITE (FHEiAHL) N—R MRICKH
LHB T Fry—TErER L £,

ZHUE, R—=RARNEESICHRET DL, TV F ¥ —UTH7DICT RLARARYA 74D 8
NA MZT 7 BATHZ EHERLET,

¥  Bank Interleaving:

3Oo0A T gy, E)(Disabled) D 2 Way D 4 Way 2 T2 M- TEETd, T 74D
FRE TSN (Disabled) T3, SDRAM E ¥ = —/UEIEIC K- T, “4 Way” BREITEREOMEREZ 1R
T2 LN TEET, MiETLHELRINT DL, IV Ea—F VAT MIRE LI HETE
ITENFERE A, SDRAM E ¥ =2 — /L OFEMIZ OV TIZ, SDRAM £ 2 —/L D A —H—|ZHBME
L EE,

32 bit Dram Memory Hole:

CDTATAE32Ey P DRAM X EV R —LEY Sy 7T 2HERERLET.COT AT A
EREED “Auto” BEIC L TBNTLEE N,

MTRR mapping mode

COTATAIMIRR ¥ v €27 E— FEFERLE9, MTRR (Memory-Type and Range
Registers) (70 vy 3 DAEYFEBOT 7 AL F v v ¥ 2 fEEFHIEIL £,

% M1689 Configuration:

<Enter>F—%7 Vv /95L&, HTA=a—1ZAVET,
Phoenix - Award WorkstationBIOS CMOS Setup Utility
M1689 Configuration
M1689 Gated Clock Disabled Item Help
PCI/14M/USB CLK PowerDown Disabled

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

M1689 Gated Clock:
ZDOT AT AL M1989 Gated Clock A& £ 7213 LET,

PCI/14H/USB CLK Powerdown:
Z DT AT AiF PCI/14H/USB Clock /XU —Z 7 v B E I3 LET,

Z—PF—r=2 T
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%  AGP Configuration:

Click <Enter> key to enter its submenu:

Phoenix - Award WorkstationBIOS CMOS Setup Utility
AGP Configuration

AGP 3.0 Transfer Mode 1x/2x/4x/8x% Item Help
Fast Write Enabled

AGP Aperture Size (MB) 256

AGP Secondary Lat Timer 20h

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

AGP 3.0 Transfer Mode:

ZOTAT ALY, AGP T ADT — FERkEE 2RI TE 4, BEARTIUEEWIZ
EVVATADT T T 4y 7 AREITEBEIZRVERELm ELET, BEVWOS T T v T 2D
— FPRBIRL 72— REV R -T2 LE2ERLTLEIN, 2OTAT AT, TDOT 7 4V
FDO[Aut|REDFE FIZL TN TLEEN,

Fast Write:

2 DDA 7 =, Disabled (%h) % 7213 Enabled (Fh) 2+ L3 c& ¥, T 741

DFXET Disabled T, BEWD AGP 7 X F XN DMHELR Y R— L TE D84, THE)
FEIRTLZENTEET, T ThRWGAIE, 8% 28R £,

AGP Aperture Size (MB):

ZOXA TV aiE, AGP TAALAPMEHATEDL VAT AAETYORBRERELET, 7/5F v
T77 497 AXEYT RLAZAN=Z2HIZHIY B ToHhiz PCL AEY 7 KU AHFHADO 55
<7,

AGP Secondary Lat Timer:

ZDOTAT AL AGP U FVBIEY A ~— DRI L F T,
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%  HyperTransport Config:

Click <Enter> key to enter its submenu:
Phoenix - Award WorkstationBIOS CMOS Setup Utility
HyperTransport Config

Hammer to M1689 Freq. 800Mhz Item Help
Hammer to M1689 Width 16bits/8 bits
M1689 HTT Tristate Disabled

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Hammer to M1689 Freq.:

M ZDT7 AT A%, LDT NAEEBEN L FEJ,

Hammer to M1689 Width:
DT AT AT, LDT NAEEERIRLET,

M1689 HTT Tristate:
ZDOT AT LIE MI1989 HTT Trisate % A ZhE 7213 LET,

% Back to Advanced Chipset Features Setup Menu:

ALI HPET:
Z DT AT A% ALIHPET (High Precision Event Timer) %A 2hE 7213 L E 3,

Init Display First:

DT AT AL, VAT LAPNEEIT D L& AGP F/21XPCL Ay MEETHHULT 720085k
WLET,

[PCISlot]: v AT ANEETH E X, £9 PClZHHLL £,
[AGP]: v AT AEESTH L&, £79 AGP ZHH1LL £,

Z—PF—r==2 T
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3-5. Integrated Peripherals

Phoenix - AwardBIOS CMOS Setup Utility
Integrated Peripherals

» OnChip IDE Device Press Enter Item Help
» OnChip PCI Device Press Enter
» SuperIO Device Press Enter
» Onboard PCI Device Press Enter

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

%  OnChip IDE Device:
<Enter>F—%7 Vv /95L&, HTA=a—IZAVET,

Phoenix - AwardBIOS CMOS Setup Utility
OnChip IDE Device

IDE Bus Master Enabled Item Help
OnChip IDE-1 Controller Enabled

OnChip IDE-2 Controller Enabled

OnChip SATA Enabled

- OnChip SATA Mode IDE

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

IDE Bus Master:
ZOF T a ik, DOSEEED FTIDE NA~ AKX U v FHBED A/ %810 % 2 3,
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OnChip IDE-1 Controller/OnChip IDE-2 Controller:

IDOTATAIZEY, —RBIOZKIDE 2> ha—F O ATRE/ AR AR U1V B2 5 Z LN
TEET, BRHN—FRRIA4 T ar bu—F%BINT5I2iF, [Disabled] (5 iR FTHE) £ R
LTL7EEN,

OnChip SATA Controller:

IDOTAT L, A F v T SATA 2> b a—F OENEH 20 2 £7,
# SATA Mode:

ZOHEAE, ATy TV TINVATA HOE— RERELET,

[IDE]: > F 72U 7V ATAIZIDE E— K& L THEREL £,
[RAID]: 4> F 72U 7V ATA IZRAID E— F& L THREL £,

%  OnChip PCI Device:

<Enter>F¥—%7 Vv /95L&, HTA=a2—IZAVET,
Phoenix — AwardBIOS CMOS Setup Utility
OnChip PCI Device

OnChip USB Controller Enabled Item Help
- USB 2.0 Controller Enabled

X - USB Keyboard Support Via 0os

X - USB Mouse Support Via os
OnChip Audio Controller Enabled

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

OnChip USB Controller:

IDTATHFZAYR—=F USB ar ba—F2lTELL9CLEST, 2OTAT L%
Disable (fEH L7200 IZ§%ET 5 &, “USB Keyboard Support Via” 3 X1 “USB Mouse Support
Via” 7 A 7 AL Integrated Peripherals (#7577 A =2 —TEIRTE EHA,

#  USB 2.0 Controller:
ZDOTATAIAR—FUSB20 a2 be—J%HTEL L5 LET,

Z—PF—r==2 T
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#  USB Keyboard Support Via:

ZOT A7 2iE, DOS BT USB ¥ —48— &35 7-0IC[BIOS] %, OS BiliC[0S]% %
WLET,

#  USB Mouse Support Via:

ZDOTATAHIZEY, DOS BEECUSB v~V AZEHT 5720 D[BIOS] %, F7izik, F721% OS
BRECIX[OS]|ZRIRT A LN TEET,

OnChip Audio Controller:
IDOTATAIA—T 1 Aar o —J5FATELL5ICLET,

%  Super 10 Device:
<Enter>F—%7 Vv /95L&, HTA=a—1ZAVET,

Phoenix - AwardBIOS CMOS Setup Utility
SuperIO Device

Onboard FDC Controller Enabled Item Help
Onboard Serial Port 1 3F8/IRQ4
Onboard Parallel Port 378/IRQ7
Parallel Port Mode SPP
X - EPP Mode Select EPP1.7
X - ECP Mode Use DMA 3

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Onboard FDC Controller:

ZOTATAMIAVAR—RNFDC a2y hr—J %A TE2 K512 LET, Enabled (iH32)
F 7213 Disabled (i L72\) IZEETEEJ, T 7 4/V hid Enabled T9,

Onboard Serial Port 1:

UYTNAR—=F1DOIUO T KL AL IRQ ZH5E L FE T, BIRFEE/2fEIX Disabled = 3F8/IRQ4 2>
2F8/IRQ3 = 3E8/IRQ4 = 2E8/IRQ3 & AUTO T, #IHIHRE L 3F8/IRQ4 T,

Onboard parallel Port:

FUR—=RRFULAR=FD VO 7 FL AL IRQ ZRETEXET, 40047 a3 U@
T& £ : Disable & 378/IRQ7 = 278/IRQ5 = 3BC/IRQ7, AL E X 378/IRQ7 T,

#  Parallel Port Mode:
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45D T a LI TE £9:SPP > EPP 2 ECP 2 ECP+EPP, #J{{l% € X SPP T,

¥  EPP Mode Select:

2 DDA T a i HEIRTE £ : EPP1.7 9 EPP1.Y, WIHHEZREILEPP 1.7 T, /X7 L)L
\— FDEF—RKEZEPPE— NIZRETDHE, 2ODEPP N—V g UNHRIRTE £,

#% ECP Mode Use DMA:

2ODF T aypPLBRTEET 123, IHMEREIXITT, T LR —bOE— K%
ECP £— RIZERET D & . DMA F v %/Li% Channel 1 7> Channel 3 & 72V 97,

%  Onboard PCI Device:

Click <Enter> key to enter its submenu:
Phoenix - AwardBIOS CMOS Setup Utility
Onboard PCI Device
Onboard LAN Controller Enabled Item Help
- LAN Boot ROM Disabled

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Onboard LAN Controller:
ZOTATHELAN 2 b —F 2 FHTEL LT LET,

# LAN Boot ROM:
DT AT MEIA R — KLANBoot ROM # il C&x 5 koI LET,

Z—PF—r==2 T
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3-6. Power Management Setup

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Power Management Setup

ACPI Suspend Type S3 (Suspend-to-RAM) Item Help
- Resume by USB from S3 Enabled
Power Button Function Instant-Off
Wake-Up by PME# of PCI Enabled
Resume by Ring Disabled
Wakeup by Alarm Disabled

X - Date(of Month) Alarm 0

X - Time (hh:mm:ss) Alarm 0:0:0
Cool’n’Quiet Technology Enabled
POWER ON Function BUTTON ONLY

X - KB Power ON Password Enter

X - Hot Key Power ON Ctrl-F1l
Restore on AC Power Loss Off

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

ACPI Suspend Type:

ZDOTATHE, ARV RE—RFOIA T @R LET,
[S1(PowerOn-Suspend)] : B A A REpEZEHFTREIC L 97,
[S3(Suspend-To-RAM)] : ¥ A2 Kt RAM A§HE 2 I ATREIC L £ 77,
% Resume by USB from S3:

WD 2ODA T a L NFEE TE F7: Disabled (EfH L72VY)  F721% Enabled EHT2) .
7 4V M & Enabled (& L 720)) T, Enabled (f£/H75) \Zi%ET D&, 4 F 7 USB
WCHBELGZ DT XTOARY MIBERT VU LIV AT AR LET, Zit,
“ACPI ARV RDOF A7 2 [SHSTRNCERESN TN D L X IZOAFETEET,

Power Button Function:

Z DT AT L% Delay 4 Sec 7> Instant-Off IZFEETE 7, 7 7 /v M Instant-Off TF, A
TAPMEBFICERARZ V2 AL EHLOSIT2 L VAT AMEIY 7 AT (V7 v =TT
Lo RU—F7) F—=PNIEDYVET, ThEBRAZ A —1—F 4 FEFOET,

Wake-up by PME# of PCI:

[Enabled] (fE FAIRE) ICRXE LTV D & &, ET AR LAN I — K72 DA 7R — K LAN X PCI
H—RIZT 7 ERATHE, VAT LEENEZTHRKE 20 £, PCL I — RNIZFEONE = Uik
Y R—FTH20ERHY ET,
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Resume by Ring:

WD 2 DOT AT L, Disabled (il L72\Y) F721% Enabled (fEAT %) N ETEET, 7
7 # )V MX Disabled (f&/H L7220Y) T, Enabled (fE/HL720)) \ZRETHEE, BT LY
PR ERITTA Ry NIRRT —F T LEV AT RO LET,

Wakeup by Alarm:

WD 2HODOF T arBNRETE £9: Disabled (il L72\y)  F 721X Enabled (BE/HT %) .
57 4 v NX Disabled (f£/7 L 7)) ¥, Enabled (f£/H75) \Zi%ET D&, RTC (VT4
ALY VT T—EPP AR RE—RNL VAT AEMONEITA 2R ETCEET,

#  Day (of Month) Alarm/ Time (hh:mm:ss) Alarm:

Aff (H) 77—ALEHT 7 —24 (hhommiss) 2R ETHZ ENTEET, BETDHA Vb
13T R_RTC, RU—F T LTV AT AEFRELET,

Cool ’n’ Quiet Technolo

ZDOA T 3 ik, AMD K8 cool and quiet BEREZ AN L7z 0 iz L= LE T,

Power On Function:
ZOTATHE, VAT LAOEREA NS HHEERIRLET,
[Password]: /SATU— REMHEA LTV AT LOEBREANILET, 2OF TV a R LT

1B, <Enter>Z LT EIV, NRAT—=FREANLTLESW, KRS KFETANTEE
. IEMEICRI LSRR T — RE AT L THER LT, <Enter>% L £,

[Hot KEY]: <F1> 7°5 <FI12>ETO ENDOMREEFH LT, AT LAOEREA AT LET,
[Mouse Left]: ~TV ADKERZ X T NI ) v 7 LT, VAT LAOBREZAIZLET,
[Mouse Right]: ~ TV ADERL L LTI Y v 7 LT, VAT AOERSA T LET,
[Any KEY]: ¥—A— FOEEOF—%HAL T, VAT LOEREA I LET,
[BUTTON ONLY]: BFRAHZ > OHREZFER LT, Y AT LOBREA AT LET,

[Keyboard 98]: “Keyboard 98" A4 —R— ROEWRA L RY U &2FEH LT, VAT LOERHE A
IZLET,

# KB Power On Password:

<Enter>F —Z {4 & HETH AT REANTHILNTEES, ABETTHE, &
EERFELTBIOS REA =2 —%K&K T L, avEa—F VAT AEZHEBTAILERDH Y 7,
WiZarvEa—FEvyy MU LIZEE BRAZ VEFALTCa Ly Ca—XOER> A
WTHZ LI TEERA, AV a—XOEREA T HIZIE, NAT— RE AT HHEERN
HoET,

# Hot Key Power On:

WD 15 DA T a U MEETE £97: Ctrl+F1 ~ Ctrl+F12, Power (FEIF) . Wake (FFONVEZ L)
AnyKey ((EBEOF—) . T 74V MI Col+FI TF, HLT DRy hF—%2@RL T, a¢
2— A DEFREANTHZENRTEET,

Z—PF—r=2 T
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Restore on AC Power Loss:

IOT AT HiE, AC EBFUCFEEDRAE LI RO L AT AEEZERLET,

[Off]: AC BIRDIEERICERNEEL TS, VAT LOERIIA 77 EFETT, VAT
LOEREA AT BT, BRAY 2T LERDH Y 7,

[On]: AC BIROFEEHERICERNEIES S L, V2T LAOBFIFEBNICA /ITRY £7°
[Former-Sts|: AC EIROFEERICERNEE TS &, VAT MTEFREENSEAET HH1OIREEIC
R £, ACERDEENREA LI L EIZV AT LADERNA 70> TWz b, EIRAEE
L7zE XLV AT AOERIIA 7102 ££TT, ACEROEENEAELZESITVAT
LDFWRNA N> T b, BFRAEE LI E XV AT AOBEFRITA 20 3,
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3-7. PnP/PCI Configurations

Phoenix - Award WorkstationBIOS CMOS Setup Utility
PnP/PCI Configurations

Resources Controlled By

x IRQ Resources

PCI/VGA Pallete Snoop

PIRQ 1
PIRQ 2
PIRQ 3
PIRQ 4
PIRQ 5
PIRQ 6
PIRQ 7
PIRQ 8

Use
Use
Use
Use
Use
Use
Use
Use

Auto (ESCD)
Press Enter

Disbaled

Auto
Auto
Auto
Auto
Auto
Auto
Auto
Auto

Item Help

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help

F5: Previous Values F6: Fail-Safe Defaults

F7: Optimized Defaults

Resources Controlled By:

TOTAT AL, ETCOEBMBLIOYT T I T RF LA BT A A 2/%LET,
[Auto(ESCD)]: > A7 A%
[Manual]: “IRQ UV YV —RA”A=2—T, FFEDIRQ U YV —REFR L T 72 &\,

% IRQ Resources:

<Enter>X—%7 Vw7 95L, VT A=a—I1Z AN ET,

St

ZHBEICR L ET,

Phoenix - Award WorkstationBIOS CMOS Setup Utility

IRQ Resources

IRQ-3 assigned to
IRQ-4 assigned to
IRQ-7 assigned to

IRQ-10 assigned to
IRQ-11 assigned to
IRQ-12 assigned to

PCI
PCI
PCI
PCI
PCI
PCI

Device
Device
Device
Device
Device
Device

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help

F5: Previous Values F6: Fail-Safe Defaults

F7: Optimized Defaults

SOTAF AL, BYAT LEDAREPCI T4 A] EE [FRFEANCEE LET,

Z—PF—r=2 T
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%  PnP/PCI Configurations Setup Menu {250 ) ¥ 7

PCI/VGA Palette Snoop:
Z DT AT AL MPEG ISA/VESA VGA 57— RS PCI/VGA TIEEN T 20 E I MhERELET,

[Enabled]: MPEG ISA/VESA VGA 71— K%, PCI/VGA TEEhT& £,
[Disabled]: MPEG ISA/VESA VGA # — KX PCI/VGA TEEH L £ A,

PIRQ 1 Use IRQ No. ~ PIRQ 8 Use IRQ No.:
DT AT AT, PCl Ay MIRY T 727 34 20 IRQ HH& HEVE- X TECHRELE
T
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3-8. PC Health Status

VAT AWEEEFE LD, Yy MUV LTEVTOREEARET D LN TEET, £,
77 COREEERLELEE T =y 7 LIc T2 b TEET, ZOMRRIT AT ADEE RN
T A= F BT 5 OIHEFITERITT,

Phoenix - AwardBIOS CMOS Setup Utility
PC Health Status

Shutdown Temperature 95°C/203°F Item Help
CPU Warning Temperature 80°C/176°F

FAN Fail Alarm Selectable Disabled

CPU FANEQ Control Enabled

- FanEQ Target Temperature 55°C/131°F

- FanEQ Temp. Tolerance 5°C/41°F

- FanEQ Start Control 70%

- FanEQ Stop Control 30%

CPU Temperature 42°C/107°F

System Temperature 30°C/100°F

PWM Temperature 42°c/107°F

SYS FAN Speed 0 RPM

CPU FAN Speed 2000 RPM

AUX FAN Speed O RPM

CPU Core Voltage 1.42 v

DDR Voltage 2.68 V

DDR VTT Voltage 1.33V

AGP VDDQ Voltage 1.52 v

ATX +12V 11.96 Vv
T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Shutdown Temperature:

IRy YOy MU UVREZRECEET, ey YORENREMEEZ D
L VAT ARELICTF Yy N LT T ey bOBRBMELEE T,

CPU Warning Temperature:

B X o — CERTHIEEET RELET, VAT LND ﬁbf'{mr%%iék\ v—
TARELTEELET, HIE50°C 725 120°C O#H TF ibf<7’_*sb\

FAN Fail Alarm Selectable:
ZOT AT HERMOIZDERIND 7 7 V2 EBIRLET,

CPU FANEQ Control:

DT AT AT CPU 77 HEDOHIEZ ATREIZ L E T, [enabled] IZREINTWDHHAE, &
DT AT LNERFTREE 720 £,

# FanEQ Target Temperature:
ZOT AT AL CPU OIREHEREZHTE LET,

Z—PF—r==2 T
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# FanEQ Temp. Tolerance:
ZOT AT HIE B IR OB IKHIR 2 3% E L E T,
#  FanEQ Start Control:

DT AT AL, VAT LEREIREO 7 7 v ORPEEE ZE L E T, CPU {EENHIED 2 20D
TATALACTRESNZRED EREBZ D E7 7 o BE#ILET,

#  FanEQ Stop Control:

ZDTATHET 7 v ORAGEEZRE L ET, CPU IRENRE FIRUTOREIC, 77 i
ZOHETHRELES,

All Voltages, Fans Speed and Thermal Monitoring:

CPU LEBREEDIRE (RT1 - CTHRIRLET) . 77 v OEESEE (CPUZ 7 &y —v 7
7V) ERARLET, INOOMIIAERETEEHA,

DT AT KIVAT AOBROELEZRLTHVET, ZOFELETTEEEA,
BERE. 77 v ORIRHEE, BEEZHET 57200 — Ry = TEGKELZ G T 256
IZ, 294H 725 297TH £ TO /O 7 KL AZFEHLET, xy NT—oI T X T X H U2 Rh—

R, E2EN6DTV0 T FVAZERT A EEEOSH DT KA b — RREE SN TV
X, BMEEEETHDICT RAUI—FKDOTO T RLAZFHEL TSV,
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3-9. Load Fail-Safe Defaults

ZIOFFaiIT 74 bDOBIOSEZr— R LT, bLEE LT, REDY AT L3754 —
v AERBLET,

3-10. Load Optimized Defaults

ZDF T a it HEREOFT 7 3L PO BIOS FEEZ T — LT, KDY AT LNT —<
VAEFEBLLET,

3-11. Set Password

ZDOAT v a X BIOS HEREMRE LD, av Ba—F~OT 7 A%EHIRLET,

3-12. Save & Exit Setup

TOF T a ABEREZEFELTBIOS By T v F A= —2K T LET,

3-13. Exit Without Saving

ZOF TV ald, BEEARGFETICBIOS Yy F T vy P A= a2 —E2 KT LET,

Z—PF—r=2 T
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ULi M1689 single chipset FZ A /5D 2> X p—rb

A-1

f1é% A. ULi M1689 single chipset K A /XD A > & |

—J

¥ : Windows A XL —7F ¢ V' J U AT L&A A h—/L L7t%. F£7 NVIDIA nForce Chipset K7 A /N

A UAR—=LLTLEE,

ARIEDOA VA =)V RIEEBER Y 2 v M,
Windows XP A L—F ¢ v 7V AT NZHS
WTWET, ZOfod 0S DA > A b—/LFJE
LY 3 v MZOWTIE, £D 0S DA v A
7V = ORFRIZHES T IEE W,

KA N\N&=a—F 1 U7 ¢ CD % CD-ROM K
TATNNEATEBE A A =N T BT TN
MAEHBIPICFETLET, BBIIZFEIT LAWY
AL ZOCDDL—hT 4 L7 NYTHEITT 7
ANELTNVI Y I L AV ARV A=
—IZA-TL &N,

A VARN—= N A= a—Z AT, I— Y IV
[Drivers]# 7 (2 &8h L £ 7, [ULi M1689 single
chipset]Z# 7 U v 7 LT 2 &V, KOE A
FRENET,

Welcome 3]

“felcome to the Integrated Driver 20921 Setup
program. This program wil install Intearated Driver
2.0921 on your computer.

Itis strongly reconmended that you exit all Windows programs
before running this Setup program.

Click Cancel to quit Setup and then close any programs you
have running. Click Next to continue vith the Setup progiam.

WARNING: This program is protected by copyricht law and
international tieaties.

Unauthorized reproduction or distribution of this program, ot any
portion of it. may result in severs civil and criminal penalties. and
il be prosecuted to the maximum extent possible under lav,

Cancel
1. [Next] 27V y27 LET,

Select Components X

Please select the diver pou want to install

ULi PCI to AGP Controller Driver

ULi MB283 SATA Controller Driver 146K
ULi MB283 SATA Raid Function 146K

Destination Folder

CiWindaws
<Back | Newt > Caneel
2. [Next] #7 Vv 27L&,
Information X
\i‘) You afqraphmwmmm

3. [OK] #27VUvyZ7L%ET,

Restarting Windows

Setup has finished copying files to your computer. Before you can
uze the program, you must restart Windows or your computer.

Choose one of the following options and click O ta finish setup.

+ Mes, | want to restart rmy computer now;

" Ma, | will restart my computer later,

4. [Yes, I want to restart my computer now. ]
ZEREN D L5 B#H LET, [Finish] % 2
Vo7 LTA VA M= LE/RTLET,

Z—PF—r=2 T
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F—F A FFA DAL 2R f—rb

B-1

f+é% B.

=T 4 F RIFTARDA A b—)L

KEDOA A M—/LRIHEWEEY =2 v ML,
Windows XP A XL —F ( VU AT AT
SNTWET, ZDMD 0S DA A h—)b
FIE L EE Y 5 > MZOW T, £D 0S D
FUAT V= DIETRIZES TLTEE W,

KA Nba—F U7 ¢ CD % CD-ROM
RIATIHATEE, A VA =T
7T ADBEBMICETLET., BEINICE
ITLRWGA. ZDOCDDLV— T4 L7 b
VCETT 7 ANELTNLI ) v T L, A
VAP A= 2T Ao TLIEE N,

AVAN—NA=Za—ZAaleh, I—Y
)V % [Drivers] % 7 128 L £ 3., [Audio
Driver]Z 7 U v 7 L TCL &V, RO A
KRINFET,

Realtek AC'97 Audio Setup (5.04) 3

Welcome to the InstaliShield Wizard for Realtek
AC'S7 Audio

The InstallShield® \wizard wil install Relek ACS7 Audio
n your computer. To continue, click Nex!

1. [Next] 27U v 27 LET,

Realtek AC'97 Audio Setup (5.04)

InstallShield Wizard Complete

Setup has fiished installng Feaek AC'S7 Audio on your
computer.

(& 3YEE. T Wari to (st my Compuler now;

€ Mo, | will restart my computer later.

Fiemave anp disks from their drives, and then click Finish to
complete setup

Finish |

2. [Yes, I want to restart my computer now. ]
BRSNS L O BEID LET, [Finish] % 7
Vo LTA VA M= VERTLET,

Z—PF—r=2 T
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LAN FZANDA4 2> X p—ob C-1

8%k C. LAN RIA DA A F—)L

RIEDOA A NM—)LFIEEHEE Y 2 v ME,
Windows XP A XL —F 4 L J 3 AT MK
SNTWET, ZOMD 0S DA A h—)b
FNEE MY 2 v MOV T, 2D 0S D
FUAT Y = OFRRICES T I,

KA NEa2—7 1+ VUF 1+ CD % CD-ROM
RIATIHHATDHE, A VA =T
77 AN AENICETLET, BEIICE
ITLRVWEA. ZOCDDL— T 4 L7 b
VCEIT T 7ANEFT TN Uy L, A
VAR A= a—Z Ao TLTIEE N,

A UA NNV A =2 =T AT, I—
)L % [Drivers] # 7 \[Z B @) L £ 4, [LAN
Driver]Z# 7 U » 27 L TL 123V, RO A
KRINFET,

Setup v1.8.41116

‘E) Found Adapter and installfupdate successfully!

1. [OK] 2270 v27 L%ET,

Z—PF—r==2 T
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ULi M5289 SATA FZANDA X p—/b

D-1

16 D. ULi M5289 SATA RTG A DA A h—)L

KEDOA A M—/LRIHEWEEY =2 v ML,
Windows XP A XL —F ( VU AT AT
DSNTVWET, ZOfd 0S DA A h—)b
FIE L EE Y 5 > MZOW T, £D 0S D
FU AT Y = ORI TSN,

KA Nba—F U7 ¢ CD % CD-ROM
RIATIHHATDHE, f A —NT 1
77 ANEBMICETLET, BEIMICE
ITLARWEA, ZOCDDL—FF 4 L2 b
VCETT 7 ANELTNLI ) v T L, A
VAR A =2 —IZ Ao TLTEE Y,

A UA NNV A2 —|Z AT, I—
JV % [Drivers] % 7 (28 L &9, [ULi M5289
SATA Driver]2 27 U » 7 LTLEE W, IRD
B NERSNET,

ULi RAID Driver Setup. E

Welcome to the InstaliShield Wizard for ULi
M5289 SATA Diiver

The InstallShield® \wizard wil install UL M5233 SATA
Diiver on your computer. To confinue, click Next.

Cancel
1. [Next] #27Uvy7 LET,

Restarting Windows

Setup has finished copying files to pour computer. Before you can
use the program, you must restart your computer.

Choose one of the following options and click OK ta finish setup.

+ Mes, | want to restart rmy computer now;

" Ma, | will restart my computer later,

2. [Yes, I want to restart my computer now. ]
FEIREN D X 9 BEID LET, [Finish] % 7
Vo Z LTA VA=V E2/TLET,

Z—PF—r=2 T
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Cool 'n' Quiet FZANDA 2R p—rb E-1

f+8% E. Cool 'n' Quiet K7 A XD A X h—/L

KRIEDA VA M= ATFIELEEHS =2 v i,
Windows XP A XL —F 4 L J 3 AT MK
SNTWET, ZOMD 0S DA A h—)b
FNEE MY =2 v MO T, 2D 0S D
F ATV = ORRIZHES T IE &,

KZA"ea2—=F 4 UTF 4 CD % CD-ROM AR o R B
FIATIHATLE, A A =T > s g

77 AN AENICETLET, BEIICE
TFLARVWEA,. ZOCDDAL—FF 4 L2 b
VCETT 7 ANELTNI ) v T L, A
VAR=L A= a2—C A>T IEE N,

AR SR = e AT B ey 2. [Yes] #2270y 7 L%ET,
/1/75:[Drivers] & 701 @gﬁ L i’a—o [COO] 'n' river - InstallShield Wizard

Quiet Driver]Z 27 V v 7 LT I2E W, RD
BE AR RSNET,

[README.TXT e for AMD Atronfm) 64 Processar Diiver

w Welcome to the InstaliShield Wizard for Athlon 64 Processor Diiver

fnstal [ oo || (e |

3. [Next] 27Uy 27 L%,

<pack || {Hen:

1. [Next] #7VUv7 LET,

Install5 & il Cancel

4. [Next] 27V v 7 L%ET,

Z—PF—r=2 T
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Athlon 64 Processor Driver - InstallShield Wizard

InstallShield Wizard Complete

InstallS cpack || Finsh cencel |

5. [Yes, I want to restart my computer now. ]
BRSNS £ O BEID L ET, [Finish]% 7
Vo7 LTA VA= EKTLET,

Power Options Properties

Power Schemes | Advanced | Hibemate | UPS |

this computer. Note that changing the settings below will modify

o ﬁ Select the power scheme with the most appropriate settings for
the selected scheme.

Power schemes

Home/Office Desk A

Home/Dffice Desk
Portable/Laptop
Presentation

uir off maritor TBfer i v

Tum off hard disks: ‘ Newer ~ ‘

Swstem standby ‘Nsver v‘

Apply

6. VAT AFHEEE 3> ba— LR
S [EIHA 7> 3 >] (Power Options) %
ER L. [B/NOBFREH] (Minimal Power
Management) D BB E % #R L T Cool
n’ Quiet ZAZNC L TLEE NN,

¥ : X E:Windows 2000 £ 7213 ME ¥ X T A
IZ DUV Tld. Windows 2000 33 & OF ME FHD
Cool *n> QuietY 7 b7 = 71 > A k=)
SN TWBEE. ADM Cool *n’ Quiet £ 7 7
[FBIRA 7> 3 > (Power Options) D RIS
RENET, TITlE. Cool ‘n’ Quiet 2H
ST B-»ic [HEE— K] (Automatic
Mode)lCiRET AMENH D £9,
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ABIT EQ (Hardware Doctor = —> 1 J 7 ) F-1

f+é% F. ABIT EQ (Hardware Doctor = —7 4 U 7 1)

ABIT EQ /%, ABIT Computer tEiZ XV fF Sz~ —HR— NIZES PCOBHCZWH Y AT A
T, BERTVAT LAY 7 VEE, CPU BEOVAT MREREOEET AT LAEERT 5

L2k, PCN— R =7 2T HEE R LET,

RKIEOA A M=V FIEEEHE Y 3 v M,
Windows XP A XL —F ( » F U AT AT
DNTWET, ZOfhd 0S DA A h—)b
FIE L EEH S 5 > MZOWTE, £D 0S D
FUAT V= DIERIZES T TEE W,

KA NEa2—7 ¢ VU7 1+ CD % CD-ROM
RIATIHATEE, A VA =T
77 APEEICIITLET, BEMICE
ITLRWEA. . ZDOCD DAL—FF 4 Lo b
VCETT 7 ANELTNLI ) v T L, A
VAR—= A= a2 —T Ao TLIEE N,

A LVA NNV A2 —|Z AT, I—
JVZ[ABIT Utility] % 7 1ZB8 L £ 9, [ABIT
EQ%7 V v 7 LTLEEW, IROMMm AR
RENET,

InstaliShield Wizard X

Welcome to the InstalShield Wizard for ABITEQ

The InstalShield® \wizard wil install ABITER on your
o continue, click Next

1L [k~ 229 97 LET,

InstaliShield Wizard

Choose Destination Location
Select foider where: Setup wil install fles,

Setup will install ABITEQ in the follawing folder

Tainstallto this folder, click Nest. To instal to a diferent folder, click Browse and select
another folder.

Destination Folder

C:4Program Files\ABITAABITEQ Brousse.

<Back Cancel ‘
2. [k~>] 22097 LET,

InstallShield Wizard

eboot

The InstalShield Wizard has suscssstull installed ABITED)
Before you an use the program, you must restart your
computer.

& g5, Want o restart my computer nows
€ No. | vl restart my compLter lat.

FReboot

Finish |

3. [Yes, I want to restart my computer now. ]
BRSNS X O BEID LE T, [Finish] % 7
Vo7 LTA VA M= VERTLET,

Z—PF—r=2 T



4 start.

4. Windows ¥V — /L R—ZRA L N LT%
ABIT EQ #47L, [A&— ] =& [Fu/
Z.] 9 [ABIT] & [ABIT EQ] %JiEIC
70w LET,

PS—C ? b,

Voltage Detection

NORMAL

5. ZOBEAERSNET, ABITEQ it,
EFIE, 77 UEE, BEOGIRY OREDL
FoRLET,
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PEZTN 2 —F g G-1

6 G. "I TAY a—F 4

Q&A:

Q:
A:

FLVWPC VAT LEMBILTSH EXITCMOS 227 VT TEHHERDHY E35?

TV, L P —R— RE2EETHERIC, CMOS 227 V7352 L2 BED LET,
CMOS V¥ v REFT T/ D 12 DRI a winb 23 DRIy a B L, 23 %L,
ZLTRIELTLES N, YATLAZFLOTRETILEE, 2P —X~v=aTVEDS
R L. Load Optimized Default % FFONAA CTL 72 &1,

BIOS EHHIINV 7T v LT LES7Y HiEo72 CPUNRTFA—FERELTLEST
BARIIEI LIEb X WTL X 5 H?

BIOS B DLIL.CPU /N T A —ZBREME VN LDV AT LD T T v 5 L&,
HIZCMOS 7 U 7 &{THo CTH A REBSETHTIEEN,

BIOS Wi CA—N—7 0 v E1-I3EEREOREERS D &, VAT LEEETEXF, H
EILAHRRENETA, A VR — FRBEELIZOTTN? AL R — FERREICRA
TAHOVLERS D ETH, XX RMA 2R %2TH RETTHN?

—HBD BIOS i E&ET 7 4V hinbA— =7 v v 7 £I3IFEEOREICEF L TH,
— R =T EFAA AR — RPKARICHEET HRK & 13720 /A, BTl KD 3
DD T TNy a—T 4 7ICE->T CMOS T—F 2B L, "— KU =T DF 7 4/ b
OWREIZFETE L ICBEO LEST, 2k, A R—FRFOHEEL, 22— —
DEWOEDOEIAAL VAR—=REBEWETFRHEOFREICRELZY . RMA 7t A% FETT
LT e 9,

1. BIFEEOERZAZIZL, 1 HBICHRAS AT LET, BENF AR D RVEA.
FER T — FE2RONT I HBIZELIAALTIIEE WD, F—R— FO<Insert>F — & L 7= F
T, BRACAREZCEMLTCUAT AEREILET, EFITEHILES, <nsert>F—%
BEL . <Delete>F—% L TBIOS Y b7 v 7= WA TELWEEZITWET,
INTHRENRIE LRWES, AT v 71 23 ERV RSN, 2T v 722 ATL
7ZEW,

2. BIREEOBFREZA7ICTH50BRa— F2HWT, Yy —Y &£, BhofEc
CCMOS Vv U 3B H D ET, Py W/ LEET 7 40 b D 1205 23121 AT L
TCMOS F—Z & MBE L., BOT 74NV D 12ICRLET, vy —I 20, Bk
BEOEREANCT 20, BRa—F2ELIALET, BFAVARZ 2L T, VA
FTAEEHLET, EFICREILZS, <Delete>F—%#L T BIOS v b7 v F—
VICAST, ELWEEEZITVWET, ZATHLRENEEL2WEA, 2T v 73 2R
AHTLTEE N,

3. AT v 72 LREILFET, A—rBR—Frb ATX B2 %7 # 2k E . CMOS 25 iE
LTCWDHRINZAA v AR— FOEMERD AL ET,
T =ANFR— L LOREREEE ZDITITED Lizb XN TTH?

IDON=aTIVOEIH D, T 7 =AY R— 7 43— LORBNEIHE-> TR L TL 2
X,

Z—P =2 T
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IEICRIBED & 256, DT 7 =Y R— FF— A0 REEZ TP < FFE L CHitl 2
T RARALZANTED LD 77 =¥ R— FIRICIE, MEICBERO RV EDERSRZ A
WP, BEREDEIROLEZFTLA LT EI VN, RRARIE, 77 = R— s bEE
ERonsd & o, WREWMALLZT 4 —7 —EIFMGEEIC Fax LTLZE W (Toflas
LTS |

#l1: ~¥P—mrR—FK (CPU, DRAM, COAST 72 £ &%) . HDD, CD-ROM, FDD, VGA
CARD, VGA #— F, MPEG #— R, SCSI #— R, ¥+ 7> R —RREEETI AT LN
I T 2WGA, LTFOFIBIES TV AT ADFER AV R—FR 2 b aeTF v 7 LTLTE
EV, ROINZ, VGA I — RUSADTRTDA L F T 2—Ah—FERY 4L CHEES LT
<TEEW,

ZRTHEE LARWGE

tDO7T Ty RELIFETADVGA I—REA VA=)V LT, VAT ANEHTLINE D
PRLTHATLEZ, TRTHEB LARWEAIL, 77 =0 R— Nl (FeiEs
HEHBM) |2 VGA #— FOEFNLL, ~HF—R— FDOEF /L4, BIOS @ ID F5. CPU OFfE
FERAL, “REOFIMICEEIC W TOFELWIHAEZILA LT ZE N,

HET 554

BYBRWZA VH T 2= AN —FRE 1 D1 DTICRLEN S, VAT LANES L b %
TUATLADE#ZF =7 LTLIEEY, VGA I — RERBEDRER otz v X T =
— AN —REELT, TOMOH— FE I OEDEMRERY AL T, AT A2 FHOMH) L
TLEEY, ZRTHERB) LA2WEA, "2OMO T — R "OMIZ 2 #d — RIZBET 2
FRRALTLLEESN, B, v —KR—RKOET L4, /S—Y 3>, BIOS®ID %%, CPU
O (EREEFHEEBR) | BLIOEZMEICOWTOHE LW ZILATIDEZERLRWN
TLEEW,

fl2: ~H¥—A—F (CPU, DRAM, COAST 72 ¥ #& %) . HDD, CD-ROM, FDD, VGA
H— R, LAN #— F, MPEG 7 — K, SCSI h— K, ¥+ R — R EZ2Et v AT LT,
YU RI—RDRTANDA A=)V, VAT LEFHEBLZY, YU FI— KD
RIANEFATLEDTHEHBNC Yy FLTLESHA, MEIT Y RA—FD K
FANRNZHDHNE LIvER A, DOS OEFEIO®R T ¢, SHIFT F—% 4 L C CONFIG.SYS &
AUTOEXECBAT #4l L CL 72&W, £72, 7% A =7 1 ¥ T CONFIG.SYS Zf&1E LT
<IEEW, ¥y RI—RFRDORIFIA N Ea— RTH{7ICY~—2 REM 875 &, v
VRA—=FRKDORIAN%OFFIZT& T, TORlEZITEIZIN,

CONFIG.SYS:

DEVICE=C:¥DOS¥HIMEM.SYS
DEVICE=C:¥DOS¥EMM386.EXE HIGHSCAN
DOS=HIGH, UMB

FILES=40

BUFFERS=36

REM DEVICEHIGH=C:¥PLUGPLAY¥DWCFGMG.SYS
LASTDRIVE=Z

VAT AEFHEB L TAHATLLEISN, YATFAREELTY Ey b LARWES, METY Y
VRA—=KRDORIANZHDLZ NNV ET, 77 =NV R— AR (EREEFES
B) 1Yoy Fhh—FOETF L, P —R—FKDET /L4, BIOSDID HF=5%ELAL, "
RIBEOFHTHICEE LW ZFEA L T Z &0,

T =ANYR— b T = AORLB OOV THI L E T,
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EREEHR..
[7 7 =1 R— MIK] OB EFREEZTLAT IHE, ROEFHET > T TZEN,

*

1.

10.

.08/ TV r—varv EHLTWY

TN 22—~ =2 TR ENTWEET AL EZRALET,
#il : KUS

. PP—R—FKDEFNVFE (REV) : vV —R— K2 [REV:*** ] L& TWDH <P —

= ROEFAFEZETAL TS,
% : REV: 1.00

3. BIOSID BEIUHIAEE : AL A7 V=0 DA -V TELES D,

CD-Title Rev. No.

RIARNR=D gy : FTRALART

ANRDT 4 27 (b LbiL) I
[Release *.**7] 72 L LFLIN TN D

W= g VFSZEFTVALET,

LT ], I Device Drives
i

Drivers Diskette Brlease 1G04
K

Floppy Disk Driver Rev.No.

508 BLOV AT ATRE LTV
AT FVr—a B ALET,
i : MS-DOS® 6.22, Windows® 95, Windows"™ NT....

. CPU: CPU DA =N —ZBIOEE (MHz) 2FALET,

Bl (A [A—H—4] OMIZIE [Intel] . [{EBE] OMIZIEL [Pentium® 4 1.9GHzZ] & 52
ALFET,

HDD : HDD & A — 71 —4 ., {I:4%, OIDEl 83X OOIDE2 D X H 5 THA L TWA &5 A
LET, T4 AVEEPDOLLIGEICEFEEZTLAL, [O] 2F=v7 (v”) LT
SV, Ty 7 BNeWEAIX, [MIDEl] v A ¥ —L BB LET,

#: [HDD]DBIDOR v 7/ A% F = v 7 L, A—H—%IZiE[Seagate] , (IAE DM IZ[ST31621A
(1.6GB) ] LFRALET,

CD-ROM KA 7 :CD-ROM KT A 7D A—H—4, {4k, OIDEl B X VOIDE2 D X5 5
THEALTCWDINETRALET, £/, 0" 2F v 7 (V) LTLKEZY, Fzv IR
BRONEAIL. “MIDE2"~ A X — e LE,

Bl : “CD-ROM R A Z7OWDR v 7 ZA%F =7 L, A =T =412 “Mitsumi”, {EEED

MIZIE “FX-400D” LA L E9,

Y ZAF N AEY (DDRSDRAM): AT AAFY DT T Fe| HBE HH, £YVa—La
VAR—R Y b, BV 2 AERE R, CAS LA T Uy, BE (MH2)O XL H 72, fEE% (DDR

DIMM) %= LEd, 72& 2. 79 FAR—2{Z, [Micron) &L, HEERAR—2
WL TF O X S ICRak L9,

FERE: 128MB, #iB: SS 16 Megx72 2.5V ECC I—/L K, EVa—/La s RK—x> b:(9) 16

Megx 8, & ¥ 2 — Lilh & 5 MTOVDDT1672AG, CAS LA 7 > 3: 2 @ (MHz): 200 MHz.

BV DDR SDRAM Ol EH Az BMOLEL ZE W, BELEZMEEZ VI 2 L— T
% ETRNMZEIZIHET,

ZOMDOA— K BEICBER L TS 00 “HdiETHD” h— REFLALET,

M DIRKRPFFE TERWGAIL, VAT AHEH L WA TRTOI— RERAL T K
Sy,

R[] oHEERELTRALTIES VY,
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CPU *
JIDE1

HDD CiDE2

CD-ROM [JIDE!L

N2 [JIDE2

VAT AAEY
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(FR—2L~—2) http://www.abit.com.tw
(CKE) http://www.abit-usa.com
(3 —u v X) http://www.abit.nl

ABIT OB GZBE W LT W& H 0N E S TENWET ABITIZT A A M) B
—H VB T— VAT AL T L—FEE L TR EZIRGEIETWEENTEDY
EFT7oH, v P —VFOREKICEERGZIRET S22 Li3d 0 THA, HiLT7 7 =
TN R — MEA~BWAEDEWTZE LIS, BEROV AT LAEBELEZY BT —
MY AT A T T L —ZIZBBWEDE WL 5N, L VEYRT RS 2 a5
B ENTEET,

ABIT TIEBEFHICHICREDOY — AU LW E - TR Y £, ik ®
B~ 2R IE 2 e BRI B 2 TR Y £9 2, FAMAZENL OEFOET A —
MIEDBEWEDERZRB L TEY E3720, T_XTOIEMICKEZTAZENRT
RV TT, LERWVWELT, EFA—ATBHOVADLENZEEELTH IR
BCEXRWEARHVFEFTOT, HOENEDITTHREWEZEET L IBEVEL R
7,

ABIT i3 @ O SE & Bt O B WL 212t 5 72010, EHEoE i+ 2
TAREBERTBYET, F——E AT V=AY R— b RSNELRDELZE
BT, FEFTV BTV RT AL T I —FIZBREWVELELIZEN,

TEHFT RS MEEZMRT 72012, LTFIZHA LETRBEEITo THA T XN,
TN THMEE MR TE 2 WHEITIE, 0T 7 = AP R— b ~BRIWAbEL
FEV, L ELOBEHIC, JVEOBWI—EREEMET H-01C, EEOZH
NEBEWNLET,

. v=aT7hEBRHILSESN., v =2 T VOERICIITEORETh- N, el
ICHERINVWETETH2EICHBALTHY 3, BN EEZREEL
TVWAEAELHVETDOT, BEY=aTAE I BHRLLTFEEN, v=a T/
WZiE~ =R — FUAMZOW T b EEAFRA TR I TWEST, v F—FA—R
WZ[AHR STV D CD-ROM 121, RIANDIENE=a T VOETT7 7414
BmEhTVEd, BETHIIL, 8o Web ¥ FEZIZFTP Y —1 kb, 7
TANEF T — RTH5ZLHTEET,

2. BFDOBIOS, Y7 bu=xT, I REFyua— RLTLEZ, 80 Web
P4 b ZEIZRY | NTRRMEICBED S ENMEE SN NV a D
BIOS # 4 7 — RLTL Z&W, $2EIBB0 X ——ZBlWabeichk
D, BFA—TarvDRIANRNESL VA=V LTLEEN,

Z—PF—r==2 T


http://www.abit.com.tw/
http://www.abit-usa.com/
http://www.abit.nl/

H-2 118 H

3. Web ¥ A M LOBEMAHFEEB LVFAQ (XHINBER) ZBHALITFE,
WA TIIA B b XHE FAQ 2 RESHE TV PETT, B0 T EAEBED
WZLTEY T, FEH LV MY Y Z7I22& £ L TiE, HOTFAQ 2 ZEL £&
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4, AVE—Ry boa—RIAN—TEZFALEEY, ZZIXEERERIEKS
< HEBNFT, ABIT Internet News 7 /L —7" (alt.comp.periphs.mainboard.abit) %
2= L) LTCIHRERBLIZY ., TNTNORBREFEY A-o720 T 57201105
BINZT+—F LT, LOTWOEAE, M ZWERIZIZO=a—R T /L—
7T TTICREE I TWET, IR RIZABR SR TS A ¥ —3 v b=
2= AT N—TTHY, EBETHENMTHZ LN TEET, ENCHLROE I 2=
2—=RATN—=TRNH N F9,

alt.comp.periphs.mainboard.abit
comp.sys.ibm.pc.hardware.chips

alt.comp.hardware.overclocking

alt.comp.hardware.homebuilt

alt.comp.hardware.pc-homebuilt

5. UET—~BRWEbELEEW, HiffRREIC>EE LTI, ABIT ZRE L
7274 A M) Ba—ZiZBRR a3, o/ GBITT A AN BEa—205
Ut T =R~k ENET, VBT —EBEHEOT AT AOMENE % L
SHEL TWETOT, BEEENMZ DA L 0 IR E MBI TE D139 T1,
BEENZTONHII—EZARNEICL T, BEHERSBLZTOY BT — LY
BlE BT COE W E D a2 b e 0 £9, F—MEE R
ERWIEAE RS L 2ORNERBABE SN TWDHIXT T, L <
TV T —lzBahRl FEN,

6. ABIT ~BRWEDEZEV, ABIT ~NEEBHRAIR D N ERTSNEL
7o T = ANYR— MEA~BF A= aBiED <E3v, 9,818 < @ ABIT
ZEOH R = b F—=LIZBHWAEDE S, HIRORGCHE, £V &7
—REDE S REGE Y — AL L T D 2T, HIBIC L0 <R R £,
ABIT AtLi 1343 A RS EL LR R EBEORNEDENKEIL T 3720,
FTRTOBEKD ZHMICEEAT 2 Z LR TERVIRR T, ¥HETIET 4 X
M) Ba—2Z@E U CREZIREWZLTRBY £972D, 7XTo=y Ra—3
DERRICT —E A2 5 2 ENTEEEA, MAETHEMRLZGY 9 X9 B
WH L BIFE, 2.8 t0 7 7 = 3R — MEICERM 2 B %I DB,
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